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Introduction
Whether you prefer film or digital photography, colour or monochrome, prints or slides,
Pudsey Camera Club offers opportunities for all members. You may be a new or an
inexperienced photographer or an experienced photographer trying new technology. There
is always something to learn. The Club offers a new syllabus every year so each year will
offer something different. The club meets on a Thursday evening at the Pudsey Library, at
19.30 for approximately one and half to two hours.
Talks and Practical Nights
You may prefer to simply sit back and enjoy a talk, receive advice and look at excellent
images taken by experienced photographers. You can also join in our practical sessions
when you can bring your own camera along and ‘have a go’ with Club equipment.
Competitions
Each year the Club holds a series of competitions and invites a number of experienced
photographers, throughout the season, to come and judge entries and to give constructive
comments and advice. This is how members really learn how to improve their photography.
There are several competitions for print, digital projected image and slide enthusiasts. All
members who are fully subscribed to the club can enter. You don’t have to be an
experienced photographer to enter, as there is a ‘Beginners’ section in the Colour Print and
Monochrome Print competitions (for more information see page 9 onwards).
(NB members can only enter competitions if they have paid their yearly subscription in full.
This amount for the yearly subscription is subject to annual review.)
Presentation Evening
The final event of the season is a special Presentation Evening when the competition awards
are given to winning members.

We hope this booklet is useful to all members and the contents will be reviewed annually.
Please do ask if there is anything you are not sure about and we will endeavour to answer
your questions.
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General Competition Rules and Requirements
General
All fully subscribed members are eligible to enter the competitions. Entries cannot be
accepted after the deadline date which is printed in the syllabus (at the present time this is
two weeks before the published competition in the syllabus, unless otherwise notified).
Judges
Club competitions are judged by experienced photographers. They are likely to be
experienced judges and some have become Associates and Fellows of the Royal
Photographic Society.
Number of entries
To be fully competitive, members should enter the maximum number of entries specified for
each competition. In the 3 round print, digital projected image or slide competitions members
need to enter each round with the maximum number of 3 entries to gain maximum marks.
However, if members wish to enter one or two rounds this is acceptable.
Eligibility
A print, digital projected image or slide will be accepted provided it has not been entered in
the same competition in any previous year, likewise members cannot submit the same
image in more than one 3 round competition, eg. if an image has been entered in a print
competition the same image cannot then be entered into a digital projected image or a slide
3 round competition. All images, negatives, prints or slides MUST be your own work, ie.
Composed and captured by you.
Titles for image entries
Prints, digital projected images and slides should have an appropriate title which can help the
judge to understand the author’s intention, so bear this in mind!
Titles are announced as the print, digital projected image or slide is shown to the audience
and the judge. The judge will then make his/her comments, which are usually very
constructive. The authors name is not disclosed with the image. At the end of the competition
authors names are announced with the winning images.
Authors who score full marks or 20 points are usually given a round of applause.
Mono or Colour
FIAP agreed a definition of monochrome work as follows, which the YPU use as they
definition for all submitted work and likewise the Pudsey CC also:“A black and white work going from very dark grey (black) to very clear grey (white) is a
monochrome work with the various shades of grey. A black and white work toned entirely in
a single colour will remain a monochrome work able to stand in the black and white
(monochrome) category; such a work can be reproduced in black and white in the catalogue
of a salon under FIAP Patronage.
On the other hand, a black and white work modified by partial toning or by the addition of one
(or more) colour, becomes a colour work (polychrome) to stand in the colour category; such
a work requires colour reproduction in a catalogue of a salon under FIAP Patronage.”
Handing in and collecting prints, digital projected image, slides
All slide, digital projected image and print entries must be handed in at least two weeks in
advance of the competition to be entered, unless otherwise notified.
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This is to allow the competition secretary time to check the entries, prepare paper work for
the competition night and to deliver the entries to the judge for advance viewing, if required.
Entries for competitions can be handed in earlier than the deadline if necessary. e.g. if a
member is going on holiday.
Please refer to your syllabus for competition dates and when to hand in entries. Copies of the
syllabus are available on club nights. The competition secretary will also announce a
reminder.
All competition entries will be kept by the competition secretary in carrying cases belonging
to the club. Please bring entries in a suitable light weight carrier which will be returned to you
after the competition. The competition secretaries try to handle entries as little as possible
but some judges like to receive the entries for preview before the competition night and
therefore some handling is necessary.
Members are responsible for collecting their own entries and carrying cases immediately
after the competition. If, for any reason, a member is unable to collect entries after the
competition, they should inform the competition secretary who will arrange to keep them until
they can be collected, preferably the following week.
Competition Categories
Some competitions require the entries to be categorised. These categories are shown below
and refer to all entries.
 Portrait - (a representation of a person or animal especially of the face, subject
poses for photographer)
 Candid – an image of a person (or persons), unaware that the photo is being
taken.
 Photo-journalism – an image, that would be newsworthy in a newspaper or
magazine
 Architecture – Buildings and parts of a building, both ancient and modern
 Record - an image of still object, which a person or persons could refer to, in
order to reproduce the object accurately. Eg. a wall plaque, statue, monument,
sculpture, stained glass window.
 Pictorial – any subject constituting a picture which does not fit into any of the
other categories, (includes landscape, cultivated flora and captive fauna)
 Sport – a game, race or competition
 Still life – still, inanimate objects.
 Natural History – untamed fauna and uncultivated flora in a natural habitat.
Cultivated flowers and obviously caged animals/birds or animals/birds within a
wild life park are not regarded as Natural History category images. The
accurate record of the subject and natural environment is the prime factor.
Evidence of man, his manipulation of his environment in any part of the picture
is undesirable and should be avoided. Entries should be accurately titled.
NB - Judges prefer Natural History images to be entitled with the Latin and common name of
the plant/animal/bird/insect.
The Inter Club categories are also printed on the syllabus. Please refer to syllabus for Inter
club dates and for the set subjects/ set themes. When placing your entries in a category
consider it carefully as you can lose marks if you make an inappropriate choice! (for more
information on Inter Club see page 13).
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Count Back rule
The following ruling is applicable to all competitions, where at the end of the competition
more than one member is sharing the winning position due to obtaining the same highest
number of marks.
‘In the event of two or more members obtaining the highest number of marks in any club
competition then their highest individual marks will determine the overall winner of the
competition. Should that not produce an outright winner then their second highest individual
marks will determine the winner and so on until their final marks are taken into consideration.
Only when all their individual marks are the same will there be joint winners of the contested
competition’. (Added May 2012 following 2012 AGM)

Preparing your prints for competition
There are several colour and monochrome print competitions to which the general rules
below apply, unless otherwise specified.
Print size
For most club competitions, prints can be up to a maximum size of 500 x 400. including
the mount. This size is also suitable for entering any of your prints into a Yorkshire
Photographic Union (YPU) competition, as this is the standard laid down by the Photographic
Alliance of Great Britain (PAGB). The thickness of the mount (all mount board plus the print)
may not exceed 4mm.
There is one competition for which the print size is more specific.


The Lynne Denton Portrait competition

The Lynne Denton Portrait competition, for this the actual print size should be no larger
than 10” x 8” and this print can then be presented on a mount no larger than 500 x 400.
Presentation of prints
Prints produced from film, slides and digital images are accepted for the print competitions.
For competition purposes the prints are all displayed together on the competition night. They
are then presented one at a time, on a light box, so the club members can view them
individually as the judge makes his/her comments. It is, therefore, an advantage for prints to
be as large as is permitted (500 x 400 including mount). Prints should be suitably mounted
on card so they look well-presented and will stand rigidly on the light box and can be viewed
to their best advantage.
Labelling Print entries
Prints must be correctly labelled please, to help the competition secretary with the paper
work.
As shown below prints should have; the name of the competition and an appropriate title
written on the back of the mount. The title is read out as the print is shown and it helps the
judge to understand the author’s intention, so bear this in mind! If required it should also give
the Category to which the print is to be judge as (eg. Harry Pitts Competition).
At the time a member pays his/her yearly subscription, a number will be allocated to that
member for identification when entering print competitions. This is the only way a print can
be identified to the author. The authors name MUST NOT be shown on any part of the
print or on the rear of the print.
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Author: 55c
Competition: Colour print
Title: Greek village at noon.
Category: Pictorial

After the authors identification number the type of print should also be shown;
C – Indicates a colour print eg. 55c
M – Indicates a mono print eg. 55m
Print size including mount 500 x 400 max. Reverse side of mount – clearly labelled as above.
When handing in prints a ‘Competition Entry Form’ must be completed and handed in with
the prints for entrant’s identification. See page 25 for example of the form.
Preparing your slides for competition
The following rules apply for the slide competitions;
 Please hand in your slides in a suitable small container or slide box with
your name on.
 All slides must be ‘spotted’ ie. They must have a small coloured paper
spot stuck on the top right hand corner of the slide when it is viewed upside
down. See diagram
 Please also title your slides and name them individually.
“Smiley face”
If slides are not suitably presented,
titled
and
named
then
the
competition
secretary
may
disqualify them.

By Jo Bloggs
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Preparing your digital images for competition
The file specifications for a digital image are as follows: The image must be a jpeg format, size 1400 x 1050 pixels at a resolution of 72
pixels, RGB profile
 Landscape files – long horizontal side should be 1400 pixels, making the other
side a ratio to this, but it cannot be over 1050.
 Portrait files – the long vertical side should be 1050, making the other side a
ratio to this, but it cannot be over 1400.

Portrait

Landscape

1050

(1050)

1400
(1400)
Files that do not conform to the standard ratio will show a white border. Therefore to mask
and avoid the white border the following can be carried out in ‘Photoshop’ or other suitable
software.
 In ‘Photoshop’ go to file – new file. Make a file 1400 x 1050 pixel at a
resolution of 72 dpi – RGB profile.
 Change the background to Black
 Open the resized image and using the move tool slide it onto the black
mask file and centre it.
 Go to layer and flatten image
 Save as a jpeg, the file name should be the tiles of the image and be shown
as follows;
00_CW_Flowers.jpg
00_then your initials_then the image title.jpg

The files should then be burnt onto a CDR to be handed in for the competition. Do not use a
DVD. The entrants name and the name of the competition should appear on the front of the
CD. Please do not use hard tipped pens such as a ball point pen. Fine marker pens are
recommended such as a Pilot CD marker pen. Do not use small labels on the front of the
CD as these can come off and jam the CD reader within the computer. If you wish to use a
label then it should be a full faced label with a centre hole. A memory stick may be used.
It must be noted the digital image will be projected as presented.
Pudsey Camera Club ver 1.8
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Print Competitions
There are several competitions which are held and finalised on one night and there are also
print competitions which have three rounds – each round being held on a separate club
night. The competitions are listed in the syllabus and also fully explained within this booklet.
Print competitions for new or less experienced members
There is a ‘Intermediate’ section which precedes each round of the Open Colour / Monochrome print competitions for less experienced photographers and new members, however a
new or less experienced member can if they wish enter the Open Colour / Monochrome
competitions but not both, details as follows:Three Round colour print competition – ‘Intermediate’ section
The entry requirements, judging and marking are exactly the same as for the Open section of
this competition but the ‘Intermediate’ entries will be judged against other ‘Intermediate’ and
the overall winner will receive a separate award. The David Horner Award
Three Round monochrome print competition - ‘Intermediate’ section
The entry requirements, judging and marking are exactly the same as for the Open section of
this competition but the ‘Intermediate’ entries will be judged against other ‘Intermediate’
entries and the winner will receive a separate award. The Councillor Coulson Award.
Any individual monochrome print scoring a maximum of 20 points in this competition will
qualify for the J W Walker Cup for the best monochrome print of the season.
Any individual colour print scoring a maximum of 20 points in this competition will qualify for
the Eric Armstrong Shield for the best colour print of the season.
The overall winner of the ‘Intermediate’ monochrome or colour print competition is eligible as
an ‘Intermediate’ for two years and then must move on to enter the ‘Open’ print competition.

Lynne Denton Rosebowl
This is a Portrait print competition and is held on one night.
Colour or monochrome prints can be entered.
Entry requirements:
A maximum of 3 prints (monochrome or colour) in the portrait category only. Members can
enter a mixture of monochrome and colour prints (but only 3 in total)
Actual print size should be no larger than 10” x 8”. This can then be presented on a mount
no larger than 500 x 400.
Judging: There will be no individual marks given. After giving his/her comments on each
print, the judge will select one final ‘winner’.
If the winner is a monochrome print it will qualify for the J W Walker best monochrome of the
season competition. If the winner is a colour print it will qualify for the Eric Armstrong Shield
best colour print of the season competition. The winner may if they wish re-print the winning
picture to a larger size (including mount no larger than 500 x 400).
.
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Harry Pitts Trophy
This is a print competition for colour and monochrome prints and it is held on one night.
Entry requirements:
A maximum of 4 prints (monochrome, colour or mixed)
Each print must be in a different category. Please see section on competition categories
for guidance. eg. Photojournalism, portrait, still life, pictorial.
Pictures should be no larger than 500 x 400 including the mount.
Judging:
After giving comments on each print, the judge will give each print a mark out of 20. The
winner will be the member with the highest score out of 80.
Any monochrome print scoring a maximum of 20 points will qualify for the J W Walker Cup
for the best monochrome print of the season or any colour print scoring a maximum of 20
points will qualify for the Eric Armstrong Shield for the best colour print of the season

Three Round Monochrome Print competition – Open section
Dave Collins Memorial Trophy
This print competition can be entered by all members, however new members can enter the
‘Intermediate’ section if they wish to compete with less experienced photographers (see
page 10 for details).
Entry requirements:
There are three rounds per season. Members can enter three monochrome prints per
round. Monochrome means ‘of tones of one colour’ but some judges do prefer pure black
and white images. See page 5 for a full definition.
Pictures should be no larger than 500 x 400 including the mount
Judging:
The judge will be invited to give comments and then give a mark out of 20 for each individual
print.
The winner:
The round winner will be the member with the highest score out of 60 at the end of the round.
The overall competition winner with the highest aggregate score over three rounds (possible
maximum score 180 points) will be awarded the Dave Collins Memorial Trophy.
Any monochrome print scoring a maximum of 20 points in this competition will qualify for the
J W Walker Cup for the best monochrome of the season.
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Three Round Colour Print competition – ‘Open’ section
The Pudsey Trophy
This competition can be entered by all members, however new members can enter the
‘Intermediate’ colour print competition if they wish to compete with less experienced
photographers (see page 10 for details).
Entry requirements:
There are three rounds per season. Members can enter three colour prints per round.
Pictures should be no larger than 500 x 400 including the mount
Judging:
The judge will be invited to give comments and then give a mark out of 20 for each individual
print.
The winner:
The round winner will be the member with the highest score out of 60 at the end of the round.
The overall winner with the highest aggregate score over three rounds (possible maximum
score 180 points) will be awarded the Pudsey Trophy
Any colour print scoring a maximum of 20 points will qualify for the Eric Armstrong Shield for
the best colour print of the season

J W Walker Print Competition
This competition is held at the end of the season and is awarded to the best monochrome
print of the season which has been entered in any of the Pudsey Camera Club print
competitions.
Any monochrome print which has been awarded the maximum of 20 marks will,
automatically, qualify for the JW Walker Cup. Prints attaining 20 marks may be taken from
the ‘Intermediate’ and ‘Open’ competition rounds.
Pictures should be no larger than 500 x 400 including the mount
On the competition night all qualifying prints which have attained 20 marks will be grouped
together.
The judge will be invited to give comments on each individual print and will then select one
print as the ‘winner’. The winner will receive the J W Walker Cup.
The winner of the Lynne Denton Rosebowl is eligible to enter this competition and may if
they wish re-print the winning picture to a larger size (including mount no larger than 500 x
400) for entry into the J W Walker best monochrome print of the season competition.

Pudsey Camera Club ver 1.8

Page 12 of 25

Members Information Booklet

Eric Armstrong Shield
This competition is held at the end of the season and is awarded to the best colour print of
the season which has been entered in any of the Pudsey Camera Club print competitions.
Any colour print which has been awarded the maximum of 20 marks will, automatically,
qualify for the Eric Armstrong Shield. Prints attaining 20 marks may be taken from the
‘Intermediate’ and ‘Open’ competition rounds.
Pictures should be no larger than 500 x 400 including the mount
On the competition night all qualifying prints which have attained 20 marks will be grouped
together.
The judge will be invited to give comments on each individual print and will then select one
print as the ‘winner’. The winner will receive the Eric Armstrong Shield.
The winner of the Lynne Denton Rosebowl is eligible to enter this competition and may if
they wish re-print the winning picture to a larger size (including mount no larger than 500 x
400) for entry into the Eric Armstrong best colour print of the season competition.
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Digital Image and Slide Competitions
There are several competitions which are held and finalised on one night and there are also
digital projected image and slide competitions which have three rounds – each round being
held on a separate club night. The following explains these competitions.

The Three Round Colour Slide Competition
This competition can be entered by all members.
Entry requirements:
There are three rounds per season.
Members can enter three slides per round in any of the categories listed, see page 5 for
details. However the three slides can all be in the same category if the member so wishes.
Judging:
The judge will be invited to give comments and then give a mark out of 20 for each individual
slide.
The winner:
The round winner will be the member with the highest score out of a possible 60 marks at the
end of the round.
The overall winner will be the member with the highest aggregate score, over three rounds
(possible maximum score 180 points) and they will be awarded The Tordoff Trophy.

The Three Round Digital Projected Image Competition
This competition can be entered by all members.
Entry requirements:
There are three rounds per season.
Members can enter three images per round in any of the categories listed, see page 5 for
details. However the three images can all be in the same category if the member so wishes.
Judging:
The judge will be invited to give comments and then give a mark out of 20 for each individual
digital image.
The winner:
The round winner will be the member with the highest score out of a possible 60 marks at the
end of the round.
The overall winner will be the member with the highest aggregate score, over three rounds
(possible maximum score 180 points) and they will be awarded The Kevin Walsh Cup.
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The M P Diffley Memorial Trophy Competition
&
Silver Screen Award
The M P Diffley Memorial Trophy is for digital projected images
The Silver Screen Award is for slides
Entry requirements are the same for both competitions:
Members may enter both competitions up to 4 digital images and up to 4 slides in a different
category in each competition. The competitions are on one night. Digital images must follow
the file specifications for a digital image.
Images/Slides which do not fit the category they have been placed in, will lose marks, so
choose carefully!
Judging:
The judge will be invited to give his comments and marks will be given out of 20 for each
digital image/slide.
The winners:
The member with the highest score out of a possible 80 marks in the digital projected image
competition will be awarded the M P Diffley Memorial Trophy. The winner of the slide
competition will receive the Silver Screen Award.

The Butcher’s Arms Pudsey Shield Competition
This is a digital projected image competition.
Members may submit up to 4 images in each set subject and set theme category, digital
images need to be handed in advance of the competition. The set subjects and set themes
are the 4 set subjects and the 4 set themes for the forthcoming seasons Inter Club Colour
Image Group and appear on the Pudsey Camera Club syllabus.
Voting is by a show of hands and members must only vote once in each category. Therefore,
members must consider all the digital images in each category and then vote for the one they
consider the best in that category.
Round 1:
The set subjects and set themes will be shown separately. The digital image with the highest
number of votes in each of the set subjects and each of the set themes will proceed to the
final. Should 2 or more image receive the highest number of votes both images will go
through to the Final.
The Final:
The winning image in each of the set subjects and each of the set themes will be shown.
The image obtaining the highest number of votes will be the winner.
Tie Break:
Should 2 or more digital image receive the highest number of votes, then those images will
be shown again and a second ballot will take place.
The winner will hold The Butchers Arms Pudsey Shield for one year. Please refer to
syllabus for Set subjects and Set themes for that year. Please see page 5 within this booklet
on Competition Categories to understand how the categories are defined.
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Miscellaneous Competitions
The Challenge Cup
This award is to recognise not only talent and expertise but hard work, enthusiasm and
dedication within the Club.
The Challenge Cup Trophy is awarded to the club member who has accumulated the highest
number of aggregate marks in the season in the three rounds of the open colour print, open
monochrome print and digital projected images competitions.
Intermediates are not eligible.

Inter Club Competition
There are a number of camera clubs in the West Yorkshire area, including Pudsey Camera
Club, which are members of the Inter Club Colour image group.
Each season these clubs hold four rounds of an Interclub Colour Competition. Each club can
submit five images per round, two images in the chosen ‘set subject/set theme’ and three
other images in the general categories.
There are agreed ‘set subjects’ and’ set themes’ for the four rounds of the Inter Club
Competition each year. The four ‘host clubs’ each chooses a set subject for the competition
round they will host. The set subjects and set themes are printed on the Club syllabus each
year.
Members are usually informed a season in advance so that they can compile their entries.
Several members of the Pudsey CC are nominated as a Selection Committee to select
images for the Interclub Competition Rounds. The images which are selected may have
been high scoring images from our club three round image competitions but members can
also submit images for selection which have not been previously seen, for the set subject/set
theme. Pudsey have done quite well in the Inter Club competition in the past and with our
growing membership it is hoped that more members will enter digital images and that Pudsey
will continue to improve their position in the Interclub Competition.
The images are judged in the same way as other competitions and are commented on
individually and given a mark out of 20.
The winner of the round is the club with the highest score.
The club with the highest aggregate score of the season wins the prestigious Interclub
Trophy and there are also awards for individual authors.
This competition is digital images only; therefore if a member wishes to enter a slide then this
must be converted into a digital image (see preparing your digital images for competition for
size etc).
You don’t have to have an image in the competition to attend and enjoy the evening at the
various venues. All members are welcome and the standard of judging and photography is
very high so there is a lot to learn! There is usually a visit to a pub afterwards. When it is our
Clubs turn to host the Inter Club members are invited to help with the organisation on the
night.
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Questions Members may want to know the answers to!
How much will it cost me?
The annual Subscription fee is paid at the start of the season in September.
This fee helps to pay for equipment, rent for the club room, competition judges, lecturers fees
and expenses. Each member then pays an entry fee if they attend the weekly meeting. There
is a raffle on every Club night and each member gets a free ticket with their entry fee. Tea,
coffee and biscuits are provided during the evening at a small cost.
Any donations of Raffle prizes are gratefully received (wine, chocolates, photographic
materials etc.).
Do I need an expensive camera to be a member?
Photography is not a cheap activity but obviously it is the individual member’s choice, how
much they spend on equipment and processing. You don’t even need a camera to be a
member. As a new member, you may want to ask for advice about what camera to
purchase. There are some practical nights when club equipment is available to members e.g.
laptop, lighting, flash facilities, backdrops, mount cutting equipment etc. Members are
required to use their own camera and film, if they want to take photographs on practical
nights or trips out. Sometimes, equipment or materials are available to buy at reduced rates
on Club nights. Members who want to enter competitions will obviously have the expense of
processing and presenting their entries. Entering slide competitions is not as costly as print
competitions because the only expense is the processing of your slide film. Prints have to be
enlarged and mounted.
We do have some books and magazines which can be lent out at no charge.
Do members need to come to every meeting?
Members can attend all or any of the sessions on the syllabus as long as they have paid the
annual subscription.
You may not want to participate in any competitions but may simply want to come along to
enjoy observe and learn.
What should I remember when I want to enter a competition?






That you must have paid your full yearly subscription.
That your entries must be handed in two weeks in advance or before the
two week deadline! Unless otherwise notified.
That all your prints and slides must be labelled with:1. the authors membership number (prints only)
2. the title of the image,
3. the category of the image (if appropriate for the competition)
4. the ‘competition title’
(eg. Monochrome/Colour/Intermediate/Open/print)
That prints, slides and digital image CD’s must be collected after the
competition, or the secretary notified if this is not possible.

Can a print, slide or digital image be entered in more than one competition?
Yes – a print, slide or digital image is eligible providing it has not been entered in the same
competition previously.
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For example; a print entered in the three round print competition may be entered in the Harry
Pitts Competition, but members cannot submit the same image in more than one three round
competition, eg. if an image has been entered in a print competition the same image cannot
then be entered into a three round digital projected image or a three round slide competition.
Why there is a maximum size for prints mounts?
The maximum mount size for Pudsey Camera Club competitions is 500 x 400 as handling is
difficult beyond this size. Mounts and prints can be smaller, however.
Are there any social events?These are usually announced in advance on Club nights. Friends, partners and spouses are
always welcome to social events with members.
Weekly Butcher’s Arms visit - Several members enjoy a drink in the Butchers Arms on
Thursday evening after the Club meeting. All members are welcome. It is a social time and
members can meet in a more informal setting. Further social events are often ‘hatched’ at
these times!
Photography Outings - The Club arrange several visits to places of interest to give
members opportunities to practise their photography as a group and exchange ideas and
knowledge. Arrangements for these visits will be announced in advance on a Club night.
Transport is usually shared by those who want to go and provided by members willing to
drive. Members without transport should consider offering a donation towards petrol
or may be asked to donate towards petrol costs on longer journeys. The choice of
visits usually depends on popular suggestion and the weather!
Meals out - The club organise several evening meals during the year, including Christmas
dinner, usually at local restaurants. Dates will be announced on Club nights.
Residential Events
The Club have had a number of residential weekends namely Scarborough, Coniston,
Pickering and Anglesey. Suggestions are put forward and a venue booked if there is enough
interest. So far they have been very enjoyable and successful and places are taken very
quickly. If members have any suggestions for outings please let a committee member know.
Awards Evening
At the end of the season there is a Special Presentation evening, usually involving a meal or
buffet and maybe a Special guest to present the Awards to competition winners.
Annual General Meeting
At the end of the season the club holds an AGM and this is open to all members. This
meeting is chaired by the President of the Club and the Officers of the Committee will give
their annual reports and officers will be nominated and elected. Members will have the
opportunities to put forward their suggestions and ideas concerning the Club at this meeting
so it is important to try and attend!
Competition rules can only be changed, by a majority vote of the members, at the Annual
General Meeting
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Is it Mono or is it Colour
FIAP agreed a ruling and definition of monochrome work as follows, which the YPU use as
they definition for all submitted work;
“A black and white work going from very dark grey (black) to very clear grey (white) is a
monochrome work with the various shades of grey. A black and white work toned entirely in
a single colour will remain a monochrome work able to stand in the black and white
(monochrome) category; such a work can be reproduced in black and white in the catalogue
of a salon under FIAP Patronage.
On the other hand, a black and white work modified by partial toning or by the addition of one
(or more) colour, becomes a colour work (polychrome) to stand in the colour category; such
a work requires colour reproduction in a catalogue of a salon under FIAP Patronage.”
Can I use other persons image / negative / print or slide?
NO, all work entered into any competition must have been composed / captured (taken) by
you, therefore your own work.
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Web sites
Pudsey Camera Club does not endorse any of these web sites they are given for your
information only.
Associations and Clubs
http://www.pudseycameraclub.co.uk/pcc/ Pudsey Camera Club
http://www.ypu.org.uk/ Yorkshire Photographic Union
http://www.pagb-photography-uk.co.uk/ Photographic Alliance of Great Britain
http://www.rps.org/ Royal Photographic Society
Shops
http://www.jessops.com/shop.cfm for equipment etc.
http://www.warehouseexpress.com/home/default.aspx for equipment etc
http://www.speedgraphic.co.uk for equipment etc
http://www.dalephotographic.co.uk/ for equipment etc
http://www.camerapricebuster.co.uk/index.html
http://www.photobox.co.uk/ for prints
http://www.proamimaging.com/ for prints
Manufactures
http://www.europe-nikon.com/home/en_GB/homepage/broad/site.html
http://www.canon.co.uk/for_home/cameras.asp
Magazines
http://www.dcmag.co.uk/
http://www.photoanswers.co.uk/Home/
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Other Clubs - Society's - Awards and Distinctions
Yorkshire Photographic Union (YPU).
Pudsey Camera Club is a member of the Yorkshire Photographic Union (YPU). There are
some 50 clubs in Yorkshire affiliated to the YPU who all benefit from the services provided by
the Union, the main ones being the panel of judges available for judging club and inter club
competitions, the panel of speakers and lecturers available to clubs, and organising the
annual exhibition. The YPU is then a member of the Photographic Alliance of Great Britain
(PAGB) which once again forms a collative of clubs and unions over Great Britain.
Yorkshire Photographic Union holds an annual competition and an exhibition. All members
can enter the Yorkshire Photographic Union Annual Print Competition regardless of whether
they have entered any Club competitions. However, members should remember that prints
are required well in advance for this Competition and will be kept for the duration of the
exhibition and therefore will not be available for any club competitions which are scheduled
around the same time. Members should consider producing duplicate images if entering the
YPU. Further details of this competition can be obtained from the clubs YPU delegate.
The Yorkshire Photographic Union does stipulate a different size of mount for prints, one
size of mount i.e. 500mm x 400mm for their annual competition - the print can be any size
but it must be presented in the correct size mount for display purposes.
The YPU exhibition follows the competition and many members enjoy this exhibition every
year and travel as a group to the elected venue. This may involve an overnight stay and the
Club Social Secretary will help with arrangements and collect any payment for these
occasions.
Photographic Alliance of Great Britain (PAGB) Awards for Photographic Merit
The Awards are open to all members of Clubs affiliated to the PAGB through their
Federations and are at three levels,
 Credit (CPAGB) - Blue badge and certificate
 Distinction (DPAGB) - Red badge and certificate
 Master (MPAGB) - Gold badge and certificate
They are held for life without any annual fee and holders are entitled to use the designated
letters after their name.
Qualification
All applicants must pre-qualify in accordance with their federation's criteria as having
supported federation photographic events eg. the YPU competitions. This support must have
been given for a minimum of 2 years for CPAGB, 3 years for DPAGB and 5 years for
MPAGB from current active photographers. A retrospective period of 10 years may be
considered.
The Royal Photographic Society's Distinctions
The Royal Photographic Society's Distinctions are recognised as measures of achievement
throughout the world.
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When you work towards a distinction you will improve your photographic skills and also know
that once you have been successful the quality of your work will be recognised worldwide.
Distinctions are awarded either on the basis of a portfolio of work which may be photographic
images or it may be research, or by successful completion of a recognised course.
There are three levels of distinction and, in addition, the Imaging Scientist Qualifications
which are specifically aimed at engineers, scientists and technologists and provide vocational
qualifications relevant to a professional career in imaging science.
The three levels of Distinction are:
 Licentiateship: The Licentiateship (LRPS) is normally the entry level
Distinction and is awarded for a good level of basic skill and competence.
 Associateship: The Associateship (ARPS) is awarded for a high standard of
technical competence and individual creative ability.
 The Fellowship: The Fellowship (FRPS) is awarded for exceptional
standards of excellence and distinguished ability.
For further details of these see the web site for each of the above.

Photoshop Tips
The YPU web site has various tips for Photoshop (Ian Lyons's Photoshop tips) these are
included here as they are available as down loads from the site.

Contrast Masking
Many images contain deep shadows with detail but also have highlights on the brink of
bleaching out. Using unconventional Photoshop selection techniques it’s possible to make
localised selections and then edit the areas as necessary.
However it can be time consuming and not always as accurate as we would like. Would it
not be nice if we could use the old time wet darkroom trick of contrast masking to control the
highlights and boost the shadows?
This method shows how it can be done in Photoshop.
• Open the image and make a duplicate layer (Layer>Duplicate layer or drag the image layer
to the page icon in the layers palette).
• Desaturate the copy layer (Image>Adjustments>Desaturate).
• Invert the copy layer (Image>Adjustments>Invert). We now have a Black & White negative.
• Apply between 5 to 10 units of Gaussian Blur to the copy layer.
• Apply Overlay Blend via the layers palette.
• Carryout appropriate colour edits etc.
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The Big Flashgun!
Early morning or late evening when the sun is just below the horizon can present the
photographer with a dilemma. There is not much light around so the shadows and even the
midtones can lack detail.
On the other hand the upper tones and highlights can be full of warm colours that we just do
not want to trade in for detail in the lower tones.
There are various techniques we can use within Photoshop to improve such images the
following is probably one of the best.
• Open an image that tends towards being dark (not necessarily underexposed).
• Make a duplicate of the image, (N.B. A separate duplicate image not an image copy on a
new layer)
• Convert the duplicate Image to Greyscale (Image>Mode>Greyscale).
• Invert the duplicate image (Image>Adjustments>Invert).
• Then apply between 4 to 8 units of Gaussian Blur, for small images use a lower value.
• The duplicate image should have the appearance of an out of focus B & W negative and
will be used as a ‘Fill Flash’.
• Now highlight the original image.
• Choose Select>Load Selection choose:
• Document – Your duplicate Image
• Channel – Gray
• Operation – New selection
• Choose Edit>Fill – choose
• Contents – 50% Grey
• Blending Mode – Colour Dodge
• The shadows and midtone areas should now be significantly brighter.
• Use the Opacity slider on the layers palette to fine tune the image.
• Duplicating the fill layer can further improve the image.
• Apply the appropriate edits for contrast, hue and saturation.
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Black and White from Colour
• Open a colour image.
• Ensure the Image is in 8 bit Mode
• Create a new adjustment layer for Hue and Saturation, click OK without making and
adjustments.
• Set the Layer Blending mode on the adjustment layer to ‘Colour’.
• Create a second adjustment layer for Hue and Saturation set and the Saturation to minus
100%.
• Set the Layer Blending mode on the second adjustment layer to ‘Normal’.
• The image may be adjusted as preferred by opening the Hue & Saturation of the first
adjustment layer.
• Changing the ‘Hue’ value emphasises a range of colours.
• Changing the ‘Saturation’ produces a greater emphasis.
• You may choose a specific colour from the drop down menu and emphasise a specific
colour.

You’re Notes ………………
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Example of Competition Entry Form

Pudsey Camera Club Competition Entry
Entrants’ number for the Club Season 20__ / 20__ ………………
Colour* / Monochrome * Digital* (*delete as necessary)
Entrants Name. ………………………………………………………………
Competition Name. …………………………………………………………
Print Title: 1. …………………………………………………………………
Print Title: 2. …………………………………………………………………
Print Title: 3. …………………………………………………………………
Print Title: 4. …………………………………………………………………

It was ruled at the PCC 2008 AGM that with all future print competitions that the entrants name should
not appear on the rear of the print. On paying full subscriptions at the start of the club season, each
member will be given a unique number which should be placed on the rear of the print together with
the tile of the print. The print must be handed into the print secretary with the completed form a
minimum of 2 weeks before the competition date.
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